Installing OpenOffice.org:
A guide for Linux, Solaris, Mac OS X, and Windows users
# Contents

Overview ........................................................................................................................................ iii

Copyright and trademark information ......................................................................................... iii

Feedback ......................................................................................................................................... iii

Acknowledgments ........................................................................................................................ iii

Modifications and updates ........................................................................................................... iii

System Requirements .................................................................................................................. 1

Linux ................................................................................................................................................ 1

Mac OS X ......................................................................................................................................... 1

Solaris ............................................................................................................................................... 1

Windows ......................................................................................................................................... 1

How to download OpenOffice.org ............................................................................................... 2

Linux, Windows and Solaris - download ......................................................................................... 2

Mac OS X – download .................................................................................................................... 2

Which type of installation? ............................................................................................................. 3

Single-user installation .................................................................................................................. 3

1 Run the setup program ................................................................................................................. 3

2 Read important information ........................................................................................................ 4

3 Accept the software license agreement ....................................................................................... 4

4 Enter user data ............................................................................................................................. 5

5 Select installation type and directory ......................................................................................... 5

6 Start copying ............................................................................................................................... 6

7 File associations for Windows ..................................................................................................... 6

8 Java setup .................................................................................................................................... 7

9 Complete installation .................................................................................................................. 7

Multi-user installation ................................................................................................................... 8

Step 1: “Network” installation ...................................................................................................... 8

Step 2: Individual user setup ......................................................................................................... 12

Installation - Mac OS X ................................................................................................................ 16

About X11 ...................................................................................................................................... 16
Overview

This chapter describes how to download OpenOffice.org and install it in Linux, Solaris, Mac OS X, and Windows environments.

Copyright and trademark information

The contents of this Documentation are subject to the Public Documentation License, Version 1.0 (the "License"); you may only use this Documentation if you comply with the terms of this License. A copy of the License is available at: http://www.openoffice.org/licenses/PDL.rtf

The Original Documentation is Installing OpenOffice.org: A guide for Linux, Solaris, Mac OS X, and Windows users. The Initial Writer(s) of the Original Documentation is/are Daniel Carrera © 2004. All Rights Reserved. (Initial Writer contact(s): dcarrera@openoffice.org. The Initial Writer contact(s) is to report errors in the documentation. For questions regarding how to use the software, subscribe to the Users Mail List and post your question there: http://support.openoffice.org/index.html.)

All trademarks within this guide belong to legitimate owners.

Feedback

Please direct any comments or suggestions about this document to: authors@user-faq.openoffice.org.

Acknowledgments

Thanks to Carla King and James Plate for contributing the instructions for Mac OS X.

Modifications and updates

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description of Change</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>14 Nov 04</td>
<td>Initial version of the document.</td>
</tr>
</tbody>
</table>
System Requirements

For accessibility support, all platforms require the Java Runtime Environment 1.4.1_01 or newer.

**Linux**

- PC with Pentium or compatible processor, or PowerPC processor
- 64 MB RAM.
- 170 MB hard disk space.
- Linux Kernel 2.0.7 or higher
- X Server with a minimum of 256 colors or gray-scale.
- glibc2 2.1.3 or higher (2.2.1 for PPC).
- VGA or higher resolution graphic device with at least 256 colours, 800 x 600.

**Solaris**

- 128 MB of RAM.
- 240 MB hard disk space.
- Solaris 7 or higher (SPARC).
- For accessibility support GNOME 2.0 or higher is required.
- VGA or higher resolution graphic device with at least 256 colours, 800 x 600.
- Gnome 2.0 required for accessibility.

**Mac OS X**

- Mac OS X v10.2 or higher
- 256 MB RAM, 512 MB recommended.
- 300 MB hard disk space (including X11).
- G4/400 or higher recommended.

**Windows**

- Pentium-compatible PC.
- Microsoft Windows 95 or higher.
- Win98 or higher required for Asian/CJK versions (2000 or higher recommended).
- 64 MB of RAM.
- 170 MB hard disk space.
How to download OpenOffice.org

The latest version of OpenOffice.org is always available from the OpenOffice.org main website. Go to the project home page ([http://www.openoffice.org](http://www.openoffice.org)) and click on Download. This takes you to the download page.

**Linux, Windows and Solaris - download**

If you are using Linux, Windows and Solaris, simply select your language, operating system and download site. You can choose any site, but it is preferred that you choose a location close to where you live.

**Mac OS X – download**

The Mac OS X port is still in development, and the download procedure is a little different:

- There is only one language available, English. But there is a localizer program that can translate the English interface to various languages.
- There is only one download site listed: The Mac OS X project page.

*Note: Currently, the Mac OS X download is only available in English. But there is a localizer available from the project page that translates the interface to various languages.*

Once you are at the Mac OS X project page, click on the Download link. Then select any download site (preferably one close to where you live). A list of files will appear:

### Index of `/MacOSX`

<table>
<thead>
<tr>
<th>Name</th>
<th>Last modified</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parent Directory</td>
<td>03-Apr-2004 11:08</td>
<td>-</td>
</tr>
<tr>
<td>Ooo 1.1.0 031006 MacOSX Install en.tar.gz</td>
<td>10-Oct-2003 15:10</td>
<td>77.5M</td>
</tr>
<tr>
<td>ooo103darwinx.dmg.gz</td>
<td>22-Jun-2003 01:29</td>
<td>169.4M</td>
</tr>
<tr>
<td>ooo103darwinx.dmg.gz</td>
<td>22-Jun-2003 04:31</td>
<td>35.8M</td>
</tr>
<tr>
<td>ooo103darwinx Macosx developer.tar.gz</td>
<td>20-Aug-2003 04:26</td>
<td>79.4M</td>
</tr>
</tbody>
</table>

Select the file `ooo103darwinx.dmg.gz`.

The download size is about 170MB, which takes about 20 minutes to download on a broadband connection.
Which type of installation?

This guide describes three kinds of installation options: single-user, multi-user and Mac OS X. How do you know which one to pick?

- If you are running Mac OS X, then pick the **Mac OS X installation**. Otherwise, read on.
- If you prefer to install software as Administrator/root and run it as a regular user, go to the **Multi-user installation**.
- If you do not have to login to use your computer, or you are not familiar with Administrator/root installations, use the **Single-user installation**.

Single-user installation

This option is available for Linux, Solaris and Windows (all versions). The procedure is described only once since it is nearly identical for all of these platforms. Platform-specific comments are included when needed.

1 Run the setup program

Enter the installation directory for your platform. Then find the setup program and run it.

This program is called **setup.exe** under Windows. Under Linux and Solaris it is called **setup**.
2 Read important information

After the Welcome screen, you are shown some important information about OpenOffice.org. You should read this page if you have not done so before.

Click Next twice to continue.

3 Accept the software license agreement

OpenOffice.org is released under a dual LGPL/SISSL license scheme.

The LGPL is the Lesser General Public License. The SISSL is the Sun Industry Software Standard License. Both are OSI-approved open source licenses. Both allow unrestricted distribution of OpenOffice.org, whether it is for free or at a profit.

If you are not familiar with these licenses, you should read them now.

Note: You will need to scroll to the bottom of the page before you can proceed with the installation.
4 Enter user data

You can now enter some user information if you wish.

*Note:* This step is entirely optional. This data will not be sent to the OpenOffice.org team. This is exclusively for your personal use. Some OpenOffice.org features can take advantage of this information (for example, the automatic Business Card creator).

After OpenOffice.org is installed, you can always change this information under **Tools > Options > OpenOffice.org > User Data**.

5 Select installation type and directory

Next you need to select the installation type and the installation directory. In most cases, you can just accept the defaults.

*Note for advanced users:* If you want to install the XHTML/XML export filters, you need to choose Custom Installation.
Unless you are upgrading, the program will need to create the installation directory.

Click Yes.

### 6 Start copying

Take a moment now to double-check all your choices. If you wish to change anything, press the Back button to return to previous steps.

If you are happy with all the settings, you can press Install. **Note:** if you press Install here you will not be able to go back and change your settings unless. However, you will still be able to cancel the installation process.

### 7 File associations for Windows

If you are running Windows, you can choose to associate MS Office files with OpenOffice.org. This means that, for instance, Word documents will open in OpenOffice.org Writer instead of Word.

This is simply your choice of default application. You will still be able to open your MS Office files with either program by going to File > Open.

These settings can be changed later on if you wish.
8 Java setup

Some of the functionality present in OpenOffice.org requires that you have a current version of the Java Runtime Environment (JRE) in your computer.

If you do not have a JRE installed you can still proceed with the OpenOffice.org installation. Be aware that you will lose a small portion of the OpenOffice.org functionality.

In particular, the accessibility features of OpenOffice.org depend on having Java 1.4.2 or later installed in your system.

If necessary, you can download Java at no cost from the Sun website: http://java.sun.com/j2se/1.4.2/download.html

9 Complete installation

After you click OK, the installation begins. The installation process takes a few minutes.

When all the steps have been completed, click Complete to finish the installation.
Multi-user installation

The installation procedure is nearly identical in all of these operating systems. Therefore, it will be described only once with appropriate platform-specific comments.

The multi-user installation comprises two main steps:

1. The “network” installation (that is just a name, you do not need to have a network for this).
2. The individual user setup.

Step 1: “Network” installation

1 Login as Administrator / root

The network installation has to be performed as Administrator under Windows NT/2000/XP or as root under Linux and Solaris.

2 Run the setup program in “network” mode

After you have inserted the CDROM, you will have to run the setup program in “network” mode.

• Under Windows NT/2000/XP:

  Open the Start menu, choose Run, and type in the Open box:

  X:\Windows\setup -net

  Here “X” is the drive letter of your CDROM drive.

• Under Linux and Solaris:

  If the CDROM is mounted in /mnt/cdrom open a terminal and type:

  /mnt/cdrom/Linux/setup -net  or  /mnt/cdrom/Solaris/setup –net

3 Welcome

First you will be greeted by a “welcome” dialog.

Click Next.

If the setup finds an older installation of OpenOffice.org, you will have the choice of upgrading. Unless you know what you are doing, select “install OpenOffice.org 1.1.0 in a new directory”.

Click Next.
4 Read important information

You are presented with the latest information on OpenOffice.org. Unless you are already familiar with OpenOffice.org as well as open source software, you should read the information contained here.

Click Next.

5 Read the software license agreement

OpenOffice.org is released under a dual LGPL/SISSL licensing scheme.

The LGPL is the “Lesser General Public License”. The SISSL is the “Sun Industry Software Standard License”.

Both are OSI-approved open source licenses. As such, both allow (among other things) the free redistribution of OpenOffice.org regardless of whether it is for free or for profit.

If you are not familiar with these licenses, you should read them.

Note: You will need to scroll to the bottom of the page before you can proceed with the installation.
6 Select the installation type and directory

Next you need to select the installation type and the installation directory. In most cases, you can just accept the defaults.

**Note for advanced users:** If you want to install the XHTML/XML export filters, you need to choose Custom Installation.

If the directory does not exist, you will be asked if you want to create it. Click Yes.

7 Start copying

You will be given one more opportunity to double-check all your choices. If you wish to change anything you can simply press the Back button to return to previous steps. If you are happy with all the settings, you can press Install.

**Note:** After you press Install, you will not be able to go back and change your settings. However, you will still be able to cancel the installation process.
8 Java setup

Some of the functionality present in OpenOffice.org requires that you have a current version of the Java Runtime Environment (JRE) in your computer.

If you do not have a JRE installed you can still proceed with the OpenOffice.org installation. Be aware that you will lose a small portion of the OpenOffice.org functionality.

In particular, the accessibility features of OpenOffice.org depend on having Java 1.4.2 or later installed in your system.

If necessary, you can download Java at no cost from the Sun website:
http://java.sun.com/j2se/1.4.2/download.html

9 Complete the installation

After you click on OK, the installation begins. The installation process takes a few minutes.

When all the steps have been completed, click on Complete to finish the installation.
Step 2: Individual user setup

This step must be performed for every single user who will be using OpenOffice.org. The procedure is very similar to the installation you just performed. For instance, the important information page and the software license will come up again, since each user should agree to the license before using OpenOffice.org.

1 Login as a regular user
First of all, you need to log back in using the regular user account you wish to setup.

2 Run the individual user setup program
   1) Go to the directory where you installed OpenOffice.org. For example, under Windows the default is C:\Program Files\OpenOffice.org1.1.0
   2) Go into the program subdirectory:
      C:\Program Files\OpenOffice.org1.1.0\program
   3) Run the “setup” program located there.

   WARNING: This is the directory where you installed OpenOffice.org, not the OpenOffice.org CDROM. This is a different setup program from the one you ran for the network installation.

3 Welcome and important information
First you are greeted with a welcome screen. Click Next.

Then you are shown the same “Important Information” page from the network install. Click Next.
4 Read the software license

This is the same license agreement that you saw during the “network” installation.

Each user is required to agree to this license before using OpenOffice.org.

As before, this is the LGPL/SISL dual license, and you will need to scroll to the bottom of the page before you are allowed to proceed.

5 Enter user data (optional)

You will now have the opportunity to enter some user information if you wish.

Note: This step is entirely optional. This data will not be sent to the OpenOffice.org team. This is exclusively for your personal use. Some OpenOffice.org features can take advantage of this information (for example, the automatic Business Card creator).

After OpenOffice.org is installed, you can always change this information under:

Tools > Options > OpenOffice.org > User Data

6 Select the Installation type

Note: If you do not see a dialog like the one presented here, you are probably running the wrong installation program. In that case, click Cancel and return to the instructions for Step 2.

Now you have the option to choose the installation type. In most cases, you can select
Workstation Installation.

7 Choose the installation directory

Here you choose the directory where the personal user configuration files will reside. Make sure that you select a directory you have read/write access to.

This dialog does not appear if you chose to update from a previous install. Click Next.

You will also have a chance to review the configuration options. Click Next.
8 Start copying
Take a moment now to double-check all your choices. If you wish to change anything, press the Back button to return to previous steps.
If you are happy with all the settings, you can press Install.

9 File Associations for Windows
If you are running Windows, you will have the option to associate MS Office files with OpenOffice.org.
This means that if you double-click on (say) a Word document, it will automatically open in OpenOffice.org Writer instead of Word.
These settings can be changed later on if you wish.

10 Complete installation
After you click OK, the installation begins. The installation process takes a few minutes.
Once all the steps have been completed click Complete to finish the installation.
To get OpenOffice running on your Mac OS X you're going to have to download and install the X11 system and the OpenOffice application.

**WARNING:** First, please back up your entire system. This procedure should not cause any problems, but backups are a standard safety measure and something that should be done whenever you make big changes to your system.

### About X11

The X Windows System by Apple lets people access the UNIX operating system on their Mac OS X. Developers use X11 to create graphical applications in a UNIX-based operating system, and to run any one of thousands of X11 applications available on their Mac OS X. If you’re not a developer, the only application you’re likely to use is the OpenOffice.org office suite. It’s worth it.

#### Step 1: Download and Install X11

Install the X11 operating system using the excellent instructions by Wei-Meng Lee titled [X11 and OpenOffice on Mac OS X](http://www.macdevcenter.com/lpt/a/3207).


**Note:** From time to time Apple will update X11 and, if you have automatic System Update turned on, you may see it listed. It will be safe, even preferable, to keep updating your X11 system.

#### Step 2: Download OpenOffice.org

See page 2 for instructions on how to download OpenOffice.org for Mac OS X. When the download is finished, a disk image should automatically open up in a window titled OOo 1.0.3 X11.

Make sure to read the README file to see if there's any late-breaking news is that may affect how you proceed from here on out.
Step 3: Install OpenOffice.org
Click on Install_OpenOffice.org to launch the installer and follow the instructions on screen. The four screens pictured below are just the first of many.

The process will take about 10 or 15 minutes. Below is some direction on the more confusing screens.

Step 4: Installation dependencies
When the Choose Install Folder window appears, click on Restore Default Folder. This will install OpenOffice in your Applications folder. (Due to a software bug, you cannot use the Choose button, as that will take you around in circles to your Applications folder and back again to this window.)

Continue with the install process as instructed on screen.

You will see a warning reminding you that OpenOffice.org will not look or feel like a normal Macintosh application, and that this release is intended for users who are comfortable with X11 programs.
Continue with the installation of OpenOffice.org and all its companion programs (DLCompat, ESP Ghostscript, and Fondu) as instructed on the screens.

At one point you will get a warning that XDarwin does not exist in the Applications directory. Don't panic. The program is just looking for XDarwin, which is the default platform it runs on; it does not know that you will be running it from X11. You will correct this the first time you run OpenOffice.org, at which point you will instruct your Macintosh system to use X11 for OpenOffice.org.

**Step 5: Launch X11**

At the moment, the Mac OS X port of OpenOffice.org runs on X11. You will always need to launch X11 before you launch OpenOffice.org.

The X11 system resides under **Applications > Utilities**. Click on **X11** to launch it.
Step 6: Start OpenOffice.org

Once X11 has been launched, you can run OpenOffice.org. Go to your Applications window and open the OpenOffice.org folder. Click the Start OpenOffice.org application to launch the program.

The first time you run the program you'll be asked to choose the application on which to run OpenOffice.org. In the long list displayed, click on X11.

The OpenOffice.org program will appear on your desktop. If you switch to a different application, you can return to OpenOffice.org by clicking the X11 icon in your dock.

Congratulations!! You have successfully installed OpenOffice.org in your Macintosh OS X computer.